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BELMONT LAW REVIEW 
THE 2014-2015 EDITING MANUAL 

 
INTRODUCTION 

 
Law Reviews are the way that legal academic research is published, and cite checking is an 

essential part of that process. Everyone in Law Review works on the articles and notes to get them into 
the best possible condition for publication. Remember, as a member of Law Review, you are part of a 
team of people that is undertaking a major task. Your role as cite checker is a very important part of the 
editing process. You are responsible for everything below the footnote line.1 This brief manual should 
help answer questions about the overall process; and, if you’re confused, your Lead Editor (“LE”), the 
Executive Articles Editor (“EAE”), the Executive Notes Editor (“ENE”), the Managing Editor (“ME”), 
and the Editor-in-Chief (“EIC”) are there to help. Please ask them any questions you may have. 
 

On a related note, the Law Review Office is for everyone’s use. We want to encourage interaction 
between Law Review staff members, so please feel free to come in and (quietly) hang out, ask questions, 
or work! You will feel more involved in what is going on and you will get to know your fellow 3Ls and 
2Ls. In addition, you will learn how the Belmont Law Review operates and which positions you may be 
interested in for the next year (remember, elections will be held in the spring). 

 
For any of you who are unfamiliar with the exact location of our Office, it is on your immediate 

right as you come up to the third floor of the library. If the door is locked, you can get the key from the 
person working at the main circulation desk. 
 
KEY DATES & DEADLINES 
 
October 15th   All book pulls are due, including Bunch and ILLs 

 
October 17th   Symposium 

 
October 20th   Lead Editors send out content-based and Bluebook cite check assignments 

 
October 29th   Content-based cite checks due to Lead Editors 

 
November 5th   Bluebook formatting assignments are due to Lead Editors 
 
 
THE ASSIGNMENTS 
 
 The first step in this process will be receiving your cite-checking assignment from your LE. Once 
you receive this email, you should create a folder on your computer for your cite checking assignment and 
rename the Article / Note file as follows: “[Cite checker’s Initials]_Cite Check_[Author’s Last Name]” 
(e.g., “CL_Cite Check_Lutz”). 
 

                                                        
1 The phrase “below the footnote line” could be misleading. This statement simply means that you are not 
responsible for performing grammatical and structural editing above the footnote line. However, if the author quotes 
a source in the body of the text, it is your responsibility to ensure that the quote matches the source quotation 
exactly. Additionally, you are responsible for determining whether statements the author makes in the body of the 
text require a citation. For clarification of these responsibilities, please see pages 4 and 5 of this manual.  
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HOW TO PERFORM CITE CHECKS 
 
STEP 1: LOCATING SOURCES 
 

ONLY ORIGINAL SOURCE MATERIALS ARE ACCEPTABLE. 
 
1. Belmont Law Library 

 
a. Physically search for books or request them via library’s website:  

http://lib.belmont.edu:7008/vwebv/searchBasic?sk=law. 
 

b. Use your Law Review account for 90-day checkout. 
 

c. All books must remain in the Office.  
 

2. Westlaw / LexisNexis 
 

a. Westlaw and Lexis have the original reporter image in PDF form for most cases. If it is 
available, the link is located in the top left-hand corner of the case in Westlaw. 

 
b. If Westlaw and Lexis do not have the original reporter image, you will need to scan the case 

from a hard copy register. 
 

c. GENERAL WESTLAW AND LEXIS DOWNLOADS DO NOT SUFFICE, except as 
temporary verification while you wait for a hard copy of the source to arrive. 

 
d. Generally, you will only use Westlaw to locate the original reporter image of cases. 

WESTLAW DOES NOT CONTAIN THE ORIGINAL IMAGE OF OTHER TYPES OF 
SOURCES. 

 
3. HEINOnline 

 
a. HEINOnline is a collection of legal titles containing over 70 million pages in PDF format.  

 
b. HEINOnline provides coverage of more than 1,400 law and law-related periodicals such as 

the Law Journal Library, English Reports, American Law Institute Library, the Congressional 
Record Bound volumes in their entirety, complete coverage of the U.S. Reports back to 1754, 
the Federal Register from inception in 1936, the Code of Federal Regulations (CFR) from 
inception in 1938, all U.S. Treaties, and much more. Please visit the website for a complete 
list of its subscribed libraries. 

 
4. Early American Imprints (“EAI”) 

 
a. EAI is a digital collection of virtually every book, pamphlet, and broadside published in 

America over a 180-year period. 
 

b. EAI has over 37,000 holdings and 2.3 million original page images available online. 
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5. Bloomberg Law 
 
a. Provides original images of all federal dockets, filings, and opinions since 2002 in PDF form. 

Its state coverage is spotty. But these are often materials that Westlaw and LexisNexis often 
don’t have. Access it at http://about.bloomberglaw.com/. 

 
6. Belmont’s Online Database List 

 
a. Both the Law School (http://belmont.edu/law/library/databases.html) and the University’s 

Bunch Library (http://library.belmont.edu/) have access to tens of thousands of articles in 
PDF and hundreds of books online.  For assistance, see a law librarian or Bunch librarian.  Be 
careful because not all sources can be considered an original publication source if they do not 
provide access to a PDF scan 

 
7. Bunch Library 

 
a. We have access to Bunch’s online databases (http://library.belmont.edu). 

 
b. Has a 30 day checkout, renewable online. 

 
c. You are responsible for returning books you check out. 

 
d. NEVER remove these sources from the Office. 

 
8. Inter-Library Loans (“ILLs”) 

 
a. Double-check the library’s online catalog. 

 
b. If you can’t find it there, check WorldCat (http://firstsearch.oclc.org/). If you’re requesting a 

journal article, search the online catalog to make sure the library doesn’t own the journal. 
Also search the list of online journals to make sure the library doesn’t have access to the 
journal.  

 
c. Ask a librarian or contact the Circulation Desk at lawlibrarycirculationdesk@belmont.edu. 

 
d. If you still can’t access the needed source, check the spreadsheet on the Law Review Office’s 

desktop to see if anyone else has requested an ILL for the same source. 
 

e. If your source is listed, contact that person. 
 

f. If your source is not listed, enter the required information into the spreadsheet. Next, fill out 
and submit the ILL request form (http://belmont.edu/law/library/interlibrary.html). It will 
usually take 5-10 days for the source to arrive. 

 
g. When the requested source arrives, make sure to scan the pinpoint cites, including one page 

before and after the pinpoint cites, and the title page. There is a scanner located in the Office 
as well as on the second floor of the library. If someone has contacted you and needs that 
same source, make sure to let them know when the source arrives. Also make sure to notify 
the LE of the article that that source was requested. ILLs can rarely be renewed and once an 
ILL source has been returned, copyright laws make it extremely difficult to obtain it again. 
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This process might sound tedious, but such fastidiousness is necessary. Remember, if you’re 
careless and muck it up, you will have to answer to the librarians. 

 
h. NEVER remove ILLs from the Office. 

 
9. Sources Still Not Found 
 

a. If you still cannot find a source, double check that the source information is correct (title, 
author, etc.). 

 
b. Verify the source by performing an Internet search. 

 
c. Ask your LE or a librarian for assistance. DO NOT CONTACT AUTHOR(S). 
 

10. Websites 
 

a. You must try to obtain a hard copy of the material in PDF format.  
 

b. If no hardcopy is available, as a last resort, you can digitally print the website, that includes a 
timestamp. Be sure to refer to BBR 18. 
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STEP 2: SUBMITTING PDF SOURCES TO DROPBOX 
 

1. You will have access to your LE’s Dropbox account, which will be designated by the last name(s) 
of the Author(s). All PDF sources should also be saved in this folder. Notify your LE as soon as 
you have completed your citechecking. Keep in mind that you should not procrastinate because if 
your work is sloppy or incorrect, you will be required to correct it—regardless of whether the 
deadline has passed or not. 
 

2. The cite-checked copy of your assigned Article / Note should be saved as “[Cite-checker’s 
Initials]_Citechecks_[Author / Authors’ Last Name(s)]”.  

 
a. E.g., “FR_Cite Checks_Chemerinsky” 

 
3. Sources should be saved in PDF format as “[Cite-checker’s Initials]_[Short Name of 

Source]_[Type of Source]”. If the source has a long title, use the first and last words of the title, 
separated by a hyphen. 

 
a. E.g., “TR_Marbury v. Madison_Case” 
b. E.g., “WS_Trout-Yemen_Book” 
c. E.g., “GG_NSA-Spies_Newspaper Article” 

 
 
 
 
 
 
STEP 3:  CONTENT-BASED CITE CHECKING 

 
Below is a list of things you must verify for each source. Remember to turn on track changes and 

show / hide before making any changes to the Article / Note. 
 

1. Material Generally Supports Assertion – verify that the source material reasonably supports the 
assertion for which the author cites the source (no wide inferential gaps); or 
 

2. Accuracy of Direct Quotations – verify that direct quotations are EXACTLY accurate; and 
 

3. Also verify the following: 
 

a. Journal or Publication Name; 
b. Publication Date; 
c. Spelling of Author’s Name; 
d. Spelling and Wording of Title; and 
e. Starting Page Number and Pinpoint Page Number. 

 
4. Additional Sources  – In the event that the author makes an assertion that is not supported by a 

source, and you believe that the assertion requires one, add a footnote and find a source that 
supports that assertion. Typically, the source will be the same as the source cited in the preceding 
sentence.  
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STEP 4: EDITING CITATIONS (BLUEBOOK FORMATTING) 
 

Bluebook contains a rule for almost every type of citation, as well as rules within the rules for 
every component of the citation. Even if you are positive that you know a certain rule, please look it up. 
 
 We recommend that you each own your own personal copy of Bluebook and become 
intimately familiar with it. Note that the rules regarding academic writing are in the back of Bluebook. 
The Law Review also has an online Bluebook account (https://www.legalbluebook.com), the username is 
“lawreview@pop.belmont.edu” and the password is “Belmont123”.  The online version has an integrated 
search that will save you time. You should also become familiar with the Redbook, which covers things 
such as style and punctuation, as well as the Chicago Manual of Style’s rules (“CMSR”). You should 
keep detailed notes of which rules you are referring to when completing your assignments. Please be sure 
to ask your LE if you have any Bluebook questions. It is better to address any concerns you have upfront 
rather than repeat mistakes throughout the Article / Note. 
 
 Finally, the following checklist should not serve as a substitute for actually looking up the rules 
yourself. It is meant to serve as a starting point of where to look in the Bluebook. Note that in some 
instances, merely conforming to the rules as stated in this checklist will result in an incorrect citation (and 
most likely an irritated LE). The rules mentioned here are not provided in their entirety. If you do not look 
up the rule yourself, you may miss a crucial part of the citation. 
 
 
 
CHECKLIST FOR BLUEBOOKING 
 
1. Typeface for Title & Author 

 
a. Cases 

 
i. If the case is cited in full, e.g. Smith v. Jones, 123 F.3d 119 (14th Cir. 1999), then the 

case name is not italicized. BBR 2.1(a). 
 

ii. If the case is short cited, e.g., Smith, 123 F.3d at 123, then Smith is italicized. BBR 
2.1(a). 

 
1. Note that a short form for a case may be used if it clearly identifies a case 

that is cited (in either full or short form, including “id.”) in one of the five 
preceding footnotes. Six or more footnotes away require full citation. BBR 
10.9(a). 

 
iii. Use “id.” only when the preceding footnote contains only one authority. BBR 4.1. 

 
iv. The period at the end of “id.” is always italicized. BBR 4.1. 

 
v. The abbreviation for a case name depends on whether it is used in a textual sentence 

or appears as a citation in a footnote. Fewer words are abbreviated in a textual 
sentence. Case names that appear as a citation in a footnote must be abbreviated 
according to Tables 6 & 10. BBR 10.2.2. 
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b. Books 
 

i. Both the title of a book and the author’s name are in SMALL CAPS. BBRs 2.1(b), 
15.1, & 15.3.  

 
1. Remember, the shortcut for small caps: 

a. Macs – Command+Shift+K 
b. PCs – Control+Shift+K 

 
c. Law Reviews & Other Periodicals 

 
i. The author’s name is in regular type, the article’s name is in italics, and the journal 

name is in SMALL CAPS. BBRs 2.1(c), 16.2-16.5. 
 

ii. Journals must be correctly spelled and abbreviated in accordance with Table 13. If 
the journal does not appear in Table 13, abbreviate any word in the periodical name 
in accordance with Tables 10 & 13. BBRs 16.4 & 16.5. 

 
2. Capitalization 

 
a. In headings, capitalize the initial word, any word that immediately follows a colon, and all 

other words except articles, conjunctions, and prepositions of four or fewer letters. BBR 8. 
 

b. In all text, capitalize nouns referring to people or groups only when they refer to specific 
persons, offices, or bodies. The same applies to words such as “act,” “circuit,” or “court”: 
capitalize them only when they refer to a specific act, circuit, or court, not when they are used 
as a generic reference. BBR 8. 

 
i. E.g., On February 19, 2001, the District Court ruled in this case. 

ii. E.g., All district courts are bound by the rulings of the circuit court to which they 
belong. 

 
3. Court & Jurisdiction 

 
a. The name of the court and its geographical jurisdiction must comply with BBR 10.4 and 

Tables 1, 2, 7, & 10. 
 

b. Adjacent single capitals do not have a space between them. (S.D.N.Y.) 
 

c. A single capital followed by a longer abbreviation has a space between the letter and the 
abbreviation. BBR 6.1. (S. Ct. or F. Supp. 2d.) 

 
4. Pinpoints 

 
a. Make sure pinpoint citations to pages, footnotes, sections, and/or paragraphs comply with 

BBRs 3.2 & 3.3. 
 

b. To cite a footnote, give the page on which the footnote appears, “n.,” and the footnote 
number, with no space between “n.” and the footnote number. BBR 3.2(b). (“Id. at 1254 
n.80”) 
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5. The Appearance of “quoted in” versus “quoting” 
 

a. For “quoted in”: the phrase follows the cite, is separated from it by a comma, and is 
italicized. BBR 1.6(c). 

 
i. E.g., Jones v. Hamilton, 849 F.2d 243 (15th Cir. 1972), quoted in Smith v. Roe, 112 

F.3d 444 (15th Cir. 2002). 
 

b. For “quoting”: phrase is used in a parenthetical in plain type. BBR 1.6(c). 
 

i. E.g., Smith v. Roe, 112 F.3d 444(15th Cir. 2002) (quoting Jones v. Hamilton, 849 
F.2d 243 (15th Cir. 1972)). 
 

6. Direct Quotations 
 

a. Make sure the formatting of the quotation complies with BBR 5.1. 
 

b. Make sure that any omissions or alterations comply with BBR 5.2. 
 

7. Order of Signals 
 

a. When a citation string has more than one signal, the signals should be listed in the order in 
which they appear in BBR 1.2. BBR 1.3. 

 
b. Signals of the same type (i.e., all signals indicating support, all those indicating comparison, 

contradiction, or the provision of background information) should be strung together in a 
single citation sentence, using semicolons to separate them. BBR 1.3. 
 

c. Different types of signals (i.e., contradictory authority cited after supporting authority) must 
be grouped in separate citation sentences. BBR 1.3. 
 

d. If the cited authorities support only a part of the sentence and are, in accordance with BBR 
1.1, cited in a citation clause following that part and set apart by commas, the citation clause 
can contain signals of different groups without the need for separate sentences. Thus, citation 
clauses can contain both supporting and contradictory authority, separated only by a 
semicolon. BBR 1.3. 
 

8. Order of Authorities within Each Signal 
 

a. Different authorities within one signal should be listed in hierarchical order (i.e., constitutions 
before statutes), in accordance with BBR 1.4. Note that this includes subclasses within each 
class of authority (i.e., federal cases before state cases).  
 

b. Be aware of BBR 1.4’s exceptions (i.e., listing a more helpful state case before a federal 
case).  
 

9. Introductory Signals 
 

a. Introductory signals must be italicized. BBR 1.2. 
 

i. Note that in the signal “E.g.,” the comma is not italicized. BBR 1.2(a). 
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ii. In the signal “See, e.g.,” the first comma is italicized and the second comma is not 

italicized. BBR 1.3. 
 

b. Check the order of introductory signals. BBR 1.3. 
 

i. A semicolon separates sources that are of the same basic type while sources that are 
of a different basic type are placed in separate sentences. 

 
c. Check the order of authorities within each introductory signal. BBR 1.4. 

 
10. Supra & Infra References 

 
a. Supra is used to refer the reader to the footnote where the full citation appears. Never use 

supra for cases or statutes. BBR 4.2. 
 

b. Make sure that the supra and infra citations are formatted correctly. BBRs 3.5 & 4.2. 
 

i. E.g., Reich, supra note 16, at 6. 
 

c. Do Not Cross Reference Footnotes. This creates technical problems towards the end of the 
editing process. Each supra and infra should be individually, manually typed, edited, and 
checked.  

 
11. Parentheticals 

 
a. Generally, parentheticals should begin with a lower-case present participle, such as “holding” 

or “finding,” and end without punctuation. BBR 1.5. 
 

b. If the parenthetical directly quotes at least one full sentence, it should begin with a capital 
letter and contain the appropriate closing punctuation. BBR 1.5. 
 

c. A shorter parenthetical may be used where a complete phrase starting with a present 
participle is unnecessarily complex. This applies, for example, where the author lists a 
number of situations in which courts have addressed various permutations of the same point, 
as in the following example: See also Jackson v. State, 492 F. Supp. 851 (15th Cir. 2012) 
(direct review); Hidalgo v. Hughes, 963 F.3d 273 (14th Cir. 2012) (collateral review). BBR 
1.5. 

 
d. When a single citation contains multiple parentheticals, they should be in this order: 

 
(date) [hereinafter short name] (en banc) (Lastname, J., concurring) (plurality opinion) 
(per curiam) (alteration in original) (emphasis added) (footnote omitted) (citations 
omitted) (quoting another source) (internal quotation marks omitted) (citing another 
source), available at http://www.domainname.com (explanatory parenthetical), prior or 
subsequent history. 
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STEP 5: CHECKLIST FOR STYLISTIC EDITING 
 

1. Footnotes 
 

a. Make sure all footnotes are indented properly, with tabs like this → between footnote number 
and text (no spaces inserted). If you can’t see an arrow (like the one above) signifying tabs, 
toggle the show/hide function (the ¶ icon) on your computer. You must have this function 
on to see these details! 

 
b. Make sure there is a period after each footnote number (except for the author’s biographical 

info asterisk). These periods should not be italicized. Double-check this because periods are 
often inadvertently italicized when part of the footnote is italicized. 

 
c. Make sure there’s a period at the end of each footnote. 

 
d. Check short forms of citations. You will do this throughout the editing process; it can’t be 

helped. Use your best judgment as to when it will be most efficient to begin checking short 
cites.  
 

2. Quotation Marks 
 

a. Quotation marks should be smart quotes (“ ”), not straight quotes (" "). 
 

b. Check for single quotes (‘ ’) versus double quotes (“ ”). 
 

c. Check that each open quote has a closed quote. 
 

d. A quotation is usually introduced by a comma, unless that quotation is introduced by words 
such as that, whether, etc. CMSR 6.53. 

 
i. E.g., It was Emerson who wrote, “Blessed are those who have no talent!” 

ii. E.g., Was it Stevenson who said that “the cruelest lies are often told in silence”? 
 

e. Periods and commas go inside quotation marks. Colons, semicolons, question marks, and 
exclamation points go outside, unless they are part of the quote itself. CMSRs 6.8–6.9. 

 
i. E.g., I heard her say to him, “Circle K is scary at night.” 

ii. E.g., I was asked to state my “name and serial number”; yet, I have no serial number. 
iii. E.g., Which of Shakespeare’s character’s said, “All the world’s a stage”? 

 
3. Periods 
 

a. Again, all footnotes must end in a period. 
 

b. The only italicized periods are those that follow Id. 
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4. Commas 
 

a. The comma indicates the slightest break in sentence structure. It denotes a slight pause. 
Effective use of the comma involves good judgment, with ease of reading the end in view. 
CMSR 6.18. That being said, be careful not to substitute your own writing style for the 
author’s.  
 

b. Items in a series are separated by comma, including the last item (except where an ampersand 
is used to connect the items). 

 
i. E.g., We had bacon, eggs, and orange juice for breakfast.  

ii. E.g., He scored an interview with Dewey, Cheetum & Howe. 
 

c. Where a full date is given, a comma is used before and after the year. Where only the month 
is given, no comma is used. 
 

5. Colons 
 

a. It’s improper to use a colon before a series introduced by a verb or a preposition. CMSR 6.68. 
 

i. E.g., A resume should include educational background, work experience, and class 
rank. 

ii. E.g., This review is concerned with (1) Bluebooking skills, (2) general grammar, and 
(3) matters of style. 

 
b. When a colon is used within a single sentence, the first letter after the colon is lower case. 

When a colon is used to introduce a related sentence, the first letter after the colon is 
uppercase. CMSR 6.64. 

 
i. E.g., The study involves three food types: meats, fruits, and vegetables. 

ii. E.g., So the question becomes: Who can you trust? 
 

6. Dashes & Hyphens 
 

a. A hyphen joins connected words. RBR 1.56-1.61.  
 

i. E.g., Third-year associate 
 

b. An en dash is longer than a hyphen. It spans from one value to another and is used in place of 
the word “to.” It is also used to join two terms of equal weight. Note that there are no spaces 
on either side of the en dash. RBR 1.52-1.55.  

 
i. E.g., The Supreme Court split 5–4. 

ii. E.g., The Sarbanes–Oxley Act or attorney–client privilege 
 

c. An em dash is the longest of the three marks. It is used to set off an explanatory or amplifying 
element from the rest of the sentence. Note that there are no spaces on either side of the em 
dash. RBRs 1.49-1.51. 

 
i. E.g., Five people—including her husband—went on the trip  
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7. Hard Spaces 
 

a. A hard space prevents line breaks between two words. You must have show / hide on to see 
them. To insert a hard space: 

 
i. Macs: Option+Spacebar 

ii. PC: Control+Shift+Spacebar 
 

b. Ellipses have to have hard spaces, like this: “tedious . . . yet rewarding.” RBR 4.13. 
 

c. There must be a hard space between the section symbol (“§”) and the section number, like 
this: “§ 56.” RBR 4.13. 

 
8. Numbers 

 
a. Make sure that all numbers between zero and ninety-nine are spelled out. BBR 6.2(a). 

 
9. Commonly Confused Terms 

 
a. Which v. That 

 
i. Which is a relative pronoun introducing a nonrestrictive/non-limiting clause that is set 

off by commas. This clause can be left out without changing the meaning of the 
sentence; it’s simply additional information. 

 
1. E.g., Diamonds, which are expensive, often elicit forgiveness. 

 
ii. That is a relative pronoun introducing a restrictive/limiting clause that isn’t set off by 

commas. Without this clause, the meaning of the sentence would change. 
 

1. E.g., Gems that sparkle often elicit forgiveness. 
 

b. Memorandum v. Per Curiam 
 

i. A memorandum decision indicates that the court has disposed of an appeal without 
issuing an opinion. 
 

ii. A per curiam opinion is an unsigned opinion issued on behalf of the entire court, i.e., 
the author of the opinion isn’t identified. 

 
c. Don’t forget other commonly confused words such as further/farther, principle/principal, 

effect/affect, etc. 
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TRACK CHANGES 
 
 
Law Review edits articles electronically using Microsoft Word’s Track Changes function. Please make 
sure the following settings are in place before working on any article. For a Mac, go to Tools, then 
Preferences, then Track Changes, then Options (for Mac OS X, go to Word Menu, then Preferences). For 
Windows, go to Tools, then Options, then Track Changes. 
 

• For Insertions, the track method should be “Underline” and the color should be Red. 
• For Deletions, the track change method should be “Strikethrough” and the color should be Blue. 
• For Formatting, the track method should be “Color Only” and the color should be Green. 
• For Changed Lines, the track method should be “Outside Border” and the color should be Auto. 
• For Comments Color, select “by author.” 
• For Moved From, the track method should be “Double Strikethrough” and the color should be 

Gray 50%. 
• For Moved To, the track method should be “Double Underline” and the color should be Gray 

50%. 
• Accept all these changes to your setting by clicking OK. 

 
You may find it helpful to add the track changes (“Review”) toolbar to the top of your Microsoft Word 
(“MS”) window. The Review toolbar contains all of the buttons that relate to editing and tracking 
changes. To view it, go to the View menu and hover over Toolbars. 
 
INSERTING COMMENTS & ANNOTATIONS 
 
We encourage you to use comments early and often to explain any changes that might be ambiguous, to 
point out confusing editing issues, or to ask questions. Please use one of the two commenting methods. 
(1) You may use MS’s Comment option. Highlight the relevant text, go to the Insert menu and select 
Comment (or the Comment icon on the Track Changes toolbar). (2) Alternatively, you can type your 
comment between brackets near the relevant text and highlight the entire passage [like this]. MS doesn’t 
allow users to attach comments to reference text (footnotes and endnotes), so you will have to use the 
latter method for these regions of the document. Please direct each comment to the appropriate person 
using the following annotation symbol: 
 
AA (Author Attention) – Use AAs to alert the author to substantive issues: (1) textual changes that 
either clarify the author’s presentation or substantively change the analysis; (2) questions or comments 
regarding ambiguities in the piece; and/or (3) incomprehensible passages which require more attention. 
Please word your comments tactfully and provide suggestions/recommendations for improvement. 
 
LE/EE (Lead Editor/Executive Editor) – Use LE/EE notations to alert your editor to problems better 
resolved by Law Review staff than by the author, such as Bluebooking issues. Describe the nature of the 
problem, a solution, and direct the LE/EE to any potion of Bluebook or the Redbook that may be relevant 
in resolving the issue. Also use LE/EE to alert your LE to citechecking problems which require special 
care, particularly where the citation doesn’t provide enough information or where the cited source doesn’t 
seem to match the author’s text in a way that indicates that the citation is erroneous. Please explain the 
problem in as much detail as possible. 
 
RCC (Re-Citecheck) – If a source isn’t available (i.e., we’re in the process of receiving it through the 
interlibrary loan, recall, etc. or the author hasn’t provided enough information for us to locate the source), 
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place “[RCC]” next to the citation for that source. This allows your LE/EE to track the citation for future 
citechecking purposes. 
 
NOTE: Please do NOT include any rude or inappropriate comments. Even if you delete the 
comment, the author could still access it from the document’s metadata. If he/she gains access to 
this comment, it could jeopardize our Law Review’s reputation as a professional, respectful 
organization.  
 
SMALL CAPS 
 
Bluebook requires the use of SMALL CAPS for a number of different types of citations. Small caps, like 
italics and bold, is a font style and whatever method you use to bold and italicize text will work for small 
caps as well. There are at least three ways to make text appear in small caps.2 
 

• Font Menu – Highlight the text in question. Go to the Format menu and select Font (or just press 
command + D). Check the “Small Caps” box. 

• Small Caps Button – To add the button, click on the Tools menu and select Customize > 
Customize Toolbars/Menus. In the Toolbars tab, be sure the Formatting box is checked. Then go 
to the Commands tab. Scroll down the list on the right until you see “ABC Small Caps.” Click and 
drag this down to your formatting toolbar. 

• Default Small Caps Keystroke – For Windows, press control + shift + k. For Macs, press 
command + shift + k. 

 
AUTOCORRECT / AUTOFORMAT 
 
MS autoformatting is a beautiful and terrible thing. For Law Review and your other forays into legal 
writing/editing, it’s recommended that you turn off several automatic functions. 
 

• The automatic superscripting of ordinals (so that 1st doesn’t change to 1st). See BB 6.2(b)(i). 
• The copyright symbol (so that § 45(c) of a statute doesn’t automatically become § 45©). 
• The capitalized letter at the beginning of a sentence (so that Id. at 45 doesn’t change to Id. At 45). 

 
SYMBOLS 
 
Bluebook citations use “§” for “section” and “¶“ for “paragraph.”3 See BBR 6.2(c). Law Review uses em 
dashes (“—”) to set off certain passages in textual sentences. There are at least two ways to insert these 
and other symbols. 
 

• Insert Menu – Place your cursor where you would like the symbol to appear. Go to Insert menu 
and select Symbol. Go to the Special Characters tab, select the desired symbol, and click the 
Insert button. 

• Keystrokes – For commonly used symbols, you may want to assign keystrokes. Go to the Insert 
menu and select Symbol. Go to the Special Characters tab. Select the desired symbol and click 
the Shortcut Key button at the bottom of the window. If there’s an easy keystroke combination 

                                                        
2 Note, approved methods DO NOT INCLUDE (1) choosing a small-capped font (such as Copperplate 
Gothic Light) or (2) using capital letters with different font sizes (such as THIS). 
3 Technically speaking (and when are we not technical?), Bluebook requires the use of “¶” where the source is 
organized into paragraph subdivisions and the use of “para.” to designate paragraphs as organizational divisions. See 
BBR 3.3. 
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under Current Keys, you’re good to go. If there’s no keystroke assigned or if you would like to 
assign your own, place your cursor in the box under “Press new shortcut key” and press some 
combination of keys. Click the Assign button at the bottom of the Customize Keyboard window. 

 
 
 
 
 
 
 
 
CONCLUSION 
 

Please note that the deadlines are firm. However, if there are problems with the Article / Note, 
you may be forced to work beyond those deadlines. If you have outstanding sources, notify your LE as 
soon as possible, specifying the footnote number(s) and the name of the source(s). Until your LE notifies 
you otherwise, obtaining outstanding sources remains your responsibility. You are expected to continue 
assisting your LE in a reasonable manner by checking for the sources in the library or even travelling to 
local libraries to make photocopies.  

 
All subsequent steps rely on the work you have performed as a cite checker during these stages. 

Therefore, it is essential that you do your very best work. If we cannot use your work to proceed to the 
next stage of editing, you will be asked to re-edit your assignment. Please remember that your LE is 
always available whenever you need assistance, big or small. Your EAE, ENE, ME, and EIC are also 
happy to help. 

 
Lastly, the Editing Staff greatly appreciates your understanding throughout this publication. Like 

you, we are leaning as we go and it assuredly won’t always be pretty. We would be particularly grateful 
for your continued dedication and patience over the course of the next several months. But, with your 
help, we can make this an awesome volume that we are all proud of. Let’s get to work!  
 


